Animate Arayuzu, Animasyon ve
Etkilesim

Arayuz Tanitim

. Acihis Ekrani: Bu bolimde olusturacagimiz dosyanin boyutunu ve kullanilacak
programlama dilini segmemiz gerekiyor. Varsayilan ayar 1280x720 ¢6zin(rliik ve Actionscript
3.0 olarak belirlenmistir. Egitim boyunca “platform type “seceneginin Actionscript3.0 olmasina
dikkat etmeliyiz.
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Animate Arayiizii:
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Araylzde goriinen yerlesime alternatif yerlesimler sag st kosede yer alan Workspace

alanindan degistirilebilir. OGnemli Not: Eger yanlislikla alanlardan birinin penceresinin yerini

degistirirseniz ayni menliden ‘Reset “Essentials

degisecektir. Aracin 6zelliklerinin degistirilmesi icin “Segenekler” bélimindeki ayarlar
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seceneginden ilk haline dondstirilebilir.

Araglar ve kisayollar: istenilen ara¢ secildikten sonra fare imleci segilen araca gére
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degistirilmelidir. Eger alt araclar kullanilacaksa yaninda kiigiik ok simgesi olan araca farenin sol

tusuyla basili tutulmalidir. Temel araglar i¢in klavye kisayollari asagidaki gibidir.
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e Zaman Cizelgesi Arayiizii: Bu bolimde katmanlar, kareler ve zamanla ilgili ayarlar yer
almaktadir. Ayrica kirmizi ¢izgiyi, stirikledigimiz yer 6n izleme olarak sahnede gorebiliriz.

Zaman
2 Cizelgesi
...... = basligi

) Katmanlar :) Oynatma Kafasi Kareler

e Kare, anahtar kare ve bos anahtar kare: Ekranda goriinecek nesneler bir katmanda ve
bir karenin icinde yer almaldir. Kareler ayni zamanda nesnelerin ekranda goriinme
strelerini de belirler. Anahtar kareler ise belirlenen karede bir nesnenin 6zelligini
degistirmek (konum, boyut, saydamlik gibi) veya nesneyi tamamen kaldirmak veya
yenisini eklemek icin kullanilabilir. Zaman cizelgesinde icinde nesne olmayan anahtar
kare ici bos daire (cember) ile nesne olan ise i¢i dolu daire ile gosterilir.
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° Katmanlar: Adobe Animate CC belgenizde resimleri organize etmenize yardimci olur.
Diger bir katmandaki nesneleri etkilemeden, bir katmanda nesne cizebilir veya
diizenleyebilirsiniz. Zaman Cizelgesi'nde katman veya klasor adinin yanindaki kalem simgesi,
katman veya klasoriin etkin oldugunu belirtir. Birden ¢ok katman secilebilir olsa da ayni anda
sadece bir katman etkin olabilir. Bir Animate belgesi olusturdugunuzda belge, yalnizca bir
katman igerir. Belgenizdeki resim, animasyon ve diger 6geleri organize etmek icin daha fazla
katman ekleyin. Ayrica, katmanlari gizleyebilir, kilitleyebilir veya yeniden

diizenleyebilirsiniz. Olusturabileceginiz katmanlarin sayisi, sadece bilgisayarinizin bellegiyle
sinirlidir ve katmanlar, yayinlanan SWF dosyanizin boyutunu artirmaz. Yalnizca katmanlara
yerlestirdiginiz nesneler projenin dosya boyutunu etkiler. Karmasik efektler olusturmaniza
yardimci olmasi igin ¢izim ve diizenlemeyi kolaylastirmak ve katmanlari maskelemek amaciyla
ozel kilavuz katmanlarini kullanabilirsiniz.

X
Zaman cizelgesi

Bl Normal Katman
M Klasik Ara iceren Normal Katman
B Sekil Arasi iceren Normal Katman
B Kare Komut Dosyasi iceren Normal Katman B
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Bl Kare Yorumu iceren Normal Katman Kare Yorumu
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X Kilavuz Katmani
I Maske Katmani

P Maskeli Katman
D% Hareket Maske Katmani

% Hareket Maskeli Katmani
X Hareket Kilavuz Katmani
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e FPS (Frame Per Second): 1 saniyede ekranda oynatilacak kare sayisini belirler. Varsayilan
ayar olan 24 fps’nin anlami 1 saniyede ekranda eklenmis olan 24 karenin art arda
gosterilmesi demektir. Fps ayari distikce animasyonun yumusakhgi/akiciligi azalacaktir,
arttikca akicilik artacak fakat ihtiyac duyulan islem glicii de artacaktir.
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Kare Kare (frame by frame) yontemiyle bir animasyon érnegi yapmak
Ornek:

e ilk olarak animasyonun temelini olusturan “kare kare animasyon” érnegini yapacagiz. Bu
mantik karelerdeki goriintiler degistikce hareket eden bir goriintii ilizyonu yaratmaya
dayanir.

e Simdi ilk anahtar kareye asagidaki gibi bir ¢cdp adam c¢izin ve sonrasinda 5 kare sonrasina
yeni bir anahtar kare ekleyip (kisayolu F6) ¢cop adami saga dogru ilerletip elini yukari
dogru hareket ettiriyormus gibi bir hareket verin.



e 5 kare sonrasinda ¢op adami saga dogru biraz daha kaydirip elini tekrar asagiya indirin. 5
kare sonrasina ise bu kez anahtar kare yerine normal kare ekleyin (kisayolu F5).

e islemleri bitirdikten sonra Ctrl+Enter tuslarina basarak animasyonunuzu test
edebilirsiniz.

e Animasyonu uzatmak igin yukaridaki islemleri tekrarlayabilirsiniz.

Semboller

Sembol tek seferligine olusturdugunuz grafik, diigme veya film klibidir. Semboli daha sonra
belgenizin veya baska belgelerin icinde yeniden kullanabilirsiniz. Bir sembol, baska bir
uygulamadan ice aktardiginiz resimleri icerebilir. Olusturdugunuz herhangi bir sembol, otomatik
olarak gegerli belgenin kitaphginin pargasi haline gelir.

Ornek, bir semboliin Sahne Alani'nin tizerinde bulunan veya baska bir semboliin icinde
yuvalanmis bir kopyasidir. Ornek, ist 5ge semboliinden renk, boyut ve islev bakimindan farkli
olabilir. Semboli diizenlemek onun 6rneklerinin timini glinceller, ancak bir semboliin bir
ornegine efekt uygulamak sadece o 6rnegi giinceller.

Film Klipleri

Adobe Animate CC'de yeniden kullanilabilen animasyon pargalari olusturmak igin film klibi
sembollerini kullanin. Film kliplerinin ana filmin Zaman Cizelgesi'nden bagimsiz, kendilerine ait
cok kareli Zaman Cizelgeleri vardir. Bunlari, etkilesimli kontroller, sesler ve hatta baska film klibi
ornekleri icerebilen bir ana Zaman Cizelgesi icinde yuvalanmis mini zaman gizelgeleri olarak
duslinebilirsiniz.

Hareketli digmeler olusturmak igin film klibi 6rneklerini bir digme semboliiniin zaman gizelgesi
icine de yerlestirebilirsiniz. Ayrica, ActionScript ile film kliplerinin komut dosyasi yazilabilir.



Grafikler

Grafik sembolii, animasyonlarda kullanilan karelerin bir koleksiyonu veya tek bir kare
modudur. Hareketli bir grafik sembold, icine yerlestirildigi belgenin Zaman Cizelgesi'ne baghdir.

Buna karsilik, bir film klibi semboliiniin kendi bagimsiz Zaman Cizelgesi vardir. Hareketli grafik
sembolleri ana belgeyle ayni Zaman Cizelgesi'ni kullandiklarindan, animasyonlarini belge
diizenleme modunda gorintilerler.

Grafik sembollerini, statik gorlintiler icin ve ana Zaman Cizelgesi'ne baglanmis yeniden
kullanilabilen animasyon pargalari olusturmak icin kullanin. Etkilesimli kontroller ve sesler, bir
grafik semboliniin animasyon sekansinda ¢calismayacaklardir. Grafik sembolleri, zaman
cizelgeleri olmadigindan diigmelere veya film kliplerine gére FLA dosyasi boyutuna daha az
eklerler.

Diigme

Digme

Normal Fare Uzerine Getirildiginde Tiklatildiginda

Digme sembolleri, Adobe Animate CC'de dort karelik etkilesimli film klibinin 6zel bir tiridur. Bir
sembol olustururken diigme tiirl sectiginizde Animate, dort karelik bir Zaman Cizelgesi
olusturur. ilk ti¢ kare diigmenin ti¢ olasi durumunu goésterir: Yukari, Uzeri, Asagl. Dérdiincii kare
ise digmenin etkin alanini tanimlar.

e Dugmeler (Kendi digmemizi olusturalim)
o Yukari karesi: Kullanici kendisiyle etkilesime girmiyorken diigmenin gorinim.


https://helpx.adobe.com/tr/animate/kb/animate-keyboard-shortcuts.html
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o Uzerinde karesi: Kullanici kendisini segmek lizereyken diigmenin gériinimii. Fare
imleci Gzerindeyken

o Asagi karesi: Kullanici kendisini segiyorken diigmenin gériiniimi. Mouse Tusuna
basiliyken

o Vurus karesi: Kullanicinin tiklatmalarina tepki veren alan. Vurus karesini
tanimlamak istege baglidir. Digmeniz kiiclikse veya grafik alani bitisik degilse bu
kareyi tanimlamak yararh olabilir

Dligme sembolli zaman c¢izelgesi, normal bir zaman ¢izelgesi gibi dogrusal olarak oynamaz; fare
isaretcisi hareketlerine ve uygun kareye atlayarak yapilan eylemlere tepki verir.

Katman Kullanimi ve Ara Hareketler ile Animasyon Ornegi

Timeline

M| <ap > == @R[

Klasik ara, Flash CS3 ve 6nceki sliriimlerinde ara doldurmayi ifade eder ve Animate'te dncelikle
gecis amaclarina yonelik olarak devam ettirilir.

Bu aralar, daha yeni ara hareketlere benzer ancak olusturulmalari daha karmasiktir ve daha az
esneklik gosterirler. Bir klasik ara olusturmak istiyorsaniz baslangi¢ noktasi ve bitis noktasi igin
birer anahtar kare ayarlayin.

Daha yeni olan ara hareketler ise klasik hareket arasindan farkl olarak sadece baslangic icin bir
anahtar kareye ihtiyag¢ duyar. Ara hareket animasyonu, ilk ve son kare arasinda bir nesne ozelligi
icin farkh degerlerin belirtilmesiyle olusturulur. Nesne 6zellikleri; konum, boyut, renk, efekt,
filtre ve donus arasinda degisir.

Bir ara hareket olusturdugunuzda ara icinde herhangi bir kare secerek hareket sembolilinii bu
kareye tasirsiniz. Animate, Klasik aralar ve Sekil aralarinin aksine ilk kare ve sonraki anahtar kare
arasindaki karelere animasyon uygulayan bir hareket yolunu otomatik olarak olusturur.

e Oncelikle klasik hareket arasi ile bir 6rnek yapacagiz.

e Simdi ekranin solundan sagina dogru giden bir daire 6rnegini klasik hareket arasi
kullanarak birlikte yapalim.

Ornek:

e Derssitesinde 1. kisimda yer alan resimleri ve SWF dosyasini indiriniz. SWF dosyasindaki
animasyona benzer bir animasyon yapmamiz gerekiyor.

e Bunun icin resimleri sahneye ekledikten sonra anahtar karelerde ilk ve son konumlarini
degistirip zaman gizelgesinde bu iki anahtar kare arasindaki herhangi bir kareye sag
tiklayip “Create Classic Tween” segenegini segmeliyiz.



e Resimlerin ekranda gériinmesini istediginiz siire boyunca zaman ¢izelgesinde “kare”

olmasina dikkat ediniz.

e Resimlerin ekrani terketmesi icin ise ayni islemi tekrarlayabileceginiz gibi ilk yaptiginiz
animasyondaki animasyonun karelerini kopyalayip zaman cizelgesinin sonuna
yapistirdiktan sonra bu kareleri secip “Reverse Keyframes” secenegini de secebilirsiniz.
Bu bastaki anahtar kare ile sondakinin igerigini dolayisiyla animasyonun hareketini
tersine cevirecektir.

Klasik hareket arasina Hareket Rehberi Ekleme

e Klasik Arayi kullanarak Ustte ekran goriintiisii yer alan 6rnegi yapacagiz.

e Hareket rehberi eklemeli ve animasyona donme hareketi eklemelisiniz.

e Hareket rehberinin galismasi igin semboldeki beyaz noktacigin hareket rehberi gizgisine
animasyonun basinda ve sonunda tutunmus olmasina dikkat edin.



Hareket Arasi ile ayn1 6rnegi tekrarlama ve kare kopyalama ve ters
cevirme ornegi

Klasik hareket arasindan farkli olarak daha modern olan hareket arasi (motion tween)
olustururken basta ve sonda iki anahtar kareye ihtiya¢ duymaz.

Baslangicta anahtar kare varken animasyonun siirecegi zaman kadar kare (frame)
eklenmelidir.

Simdi Ustte klasik ara ile yaptigimiz 6érnegi bu kez rehber olmadan hareket arasi
kullanarak yapacagiz ve kareleri kopyalayip yapistiracagiz.

Ardinda yapistirdiginiz kareleri secerek ters gevirip sonsuz bir animasyon olusturacagiz.

Kiittiphane mantig1 ve Kullanimlari

Film Klibi (Klip iginde Klip)

Ornek: Yeni film klibi ile coklu kiitiiphane nesnesi

Cevirme isimli bir katman olusturun

Ekle > Yeni Sembol menisinden yildiz isimli bir film klibi tirinde sembol ekleyin.
Sembol ekranina yénlendirilmis olmaniz gerekiyor

Simdi cokgen aracini segip, segeneklerden yildizi segip kenar sayisini 5, boyutunu
da 0.5 olarak degistirin.

Simdi yildizi anahatsiz olarak dolgusu sari renkte cizin.

20. Kareye gidip F5’e basin ve 2-20 arasindaki herhangi bir kareye sag tiklayip
haraket arasi olustur segenegini tiklayin.

Eger nesnenin bir sembol olmasi gerektigi uyarisi gelirse evet’e tiklayin.

10. Kareye gidip F6ya basin ve yeni bir anahtar kare olusturun.

Yildiz segiliyken Modify>Transform> Rotate 90° CW (Degistir > Donustir > SY 90°
Dondir) segeneginden yildizi 90 derece donddrin.

20. Kareye gidip bu sefer saat yoniiniin tersine 90 derece dondirin.

Donen yildizini hazir fakat sahneye ekli degil. Sahneye eklemek icin
kitiphaneden film klibi sembolini strikleyip sahneye birakin.

istediginiz sayida ve biyiikliiklerde yildizlari ekledikten sonra Ctrl+Enter’a basarak
animasyonu test edin

Sekil Arasi (Shape Tween)

Sekil arasi bir sekli baska bir sekle otomatik olarak doldurmak icin kullanilan yéntemdir. Arayi
doldurma isleminde, Zaman Cizelgesi'nde belirli bir karede vektor sekli cizersiniz ve baska bir
belirli karede bu sekli degistirip baska bir sekil gizersiniz. Animate daha sonra, bir seklin basgka bir
sekle donlstigl animasyonu olusturarak aradaki karelerin igine ara sekilleri kendisi olusturur.



Ornek:

Asagidaki adimlar, Zaman Cizelgesi'nde 1. kareden 30. kareye bir sekil arasinin nasil
olusturuldugunu gosterir. Ancak, sectiginiz Zaman Cizelgesi'nin herhangi bir bélimiinde aralar
olusturabilirsiniz.

1. 1. karede, Dikdortgen araciyla bir kare gizin.

2. Ayni katmanin 30. karesini segin ve Ekle > Zaman Cizelgesi > Bos Anahtar Kare segeneklerini
belirleyerek ya da F7 tusuna basarak bos bir anahtar kare ekleyin.

3. Sahne Alani'nda, 30. kareye Oval araciyla bir daire ¢izin.
Simdi 1. karede kare iceren bir anahtar kareniz ve 30. karede daire iceren bir anahtar kareniz
var.

4. Zaman Cizelgesi'nde, iki sekli iceren katmanda iki anahtar kare arasindaki karelerden birini secin.
5. Ekle > Sekil Arasi secenegini belirleyin.
Animate, iki anahtar kare arasindaki tim karelerde sekilleri enterpole eder.

6. Arayl Onizlemek i¢in, Zaman Cizelgesi'ndeki kareler boyunca oynatma kafasini stirtikleyin.

7. Seklin yani sira hareketin de arasini doldurmak igin, 30. karedeki sekli Sahne Alani tizerinde 1.
karedeki seklin konumundan farkl bir konuma tasiyin.
Enter tusuna basarak animasyonu onizleyin.

8. Seklin renginin arasini doldurmak icin, 1. karedeki sekli, 30. karedeki sekilden farkl bir renge
ayarlayin.

9. Araya hareket hizi eklemek icin, iki anahtar kare arasindaki karelerden birini secin ve Ozellik
denetgisindeki Hareket Hizi alanina bir deger girin.
Aranin baslangicina hareket hizi uygulamak icin negatif bir deger girin. Aranin bitisine hareket
hizi uygulamak icin pozitif bir deger girin.

Metinlerde Sekil Arasi, Sekil ipucu ekleme ve kullanma
Daha karmasik veya olanak disi sekil degisikliklerini kontrol etmek igin sekil ipuglarini
kullanabilirsiniz. Sekil ipuglari, baslangic ve bitis sekillerinde birbirine karsilik gelmesi gereken
noktalari tanimlar. Ornegin, bir yiiz ciziminin ifade degisikliginin arasini dolduruyorsaniz, her iki gozii
isaretlemek igin birer sekil ipucu kullanabilirsiniz. Sonra, sekil degisikligi meydana gelirken yiiziin
bicimsiz bir diigiim haline gelmesinin yerine, her iki gbz ayirt edilebilir kalir ve gecis sirasinda ayri
olarak degisir.
Sekil ipuclari baslangic ana karesinde sari, bitis ana karesinde yesil ve bir egri lizerinde degilken
kirmizidir. Sekillerin arasini doldururken en iyi sonuclar i¢in su yonergeleri izleyin:

Karmasik sekil arasi doldurmada, ara sekiller olusturun ve sadece bir baslangig ve bitis sekli
tanimlamak yerine, onlarin arasini doldurun. Sekil ipuglarinin mantikli oldugundan emin olun.
Ornegin, bir licgen icin ti¢ sekil ipucu kullaniyorsaniz, orijinal licggende ve arasi doldurulacak tiggende
ayni sirada olmalidirlar. Sira ilk ana karede abc, ikincide acb olamaz. Sekil ipuglari, seklin sol tst
kosesinden baslayarak saat yoniniin tersine dogru yerlestirdiginizde en iyi sonucu verirler.



Sekil ipuglarint kullanma

1.
2.

Sekil arasi doldurulan bir dizideki ilk ana kareyi segin.

Degistir > Sekil > Sekil ipucu Ekle'yi secin. Baslangic sekil ipucu, sekil tizerinde bir yerde,
Ustiinde a harfi bulunan kirmizi bir daire olarak gorundr.

Sekil ipucunu isaretlenecek bir noktaya tasiyin.

Ara doldurma dizisindeki son ana kareyi segin. Bitis sekil ipucu, sekil Gizerinde bir yerde,
Ustiinde a harfi bulunan yesil bir daire olarak goriinr.

Sekil ipucunu, bitis seklinde ilk isaretlediginiz noktaya karsilik gelen noktaya tasiyin.
Sekil ipuglarinin sekil arasi doldurmayi nasil degistirdigini goriintiilemek icin animasyonu
tekrar oynatin. Ara doldurmanin ince ayarini yapmak icin sekil ipuglarini tasiyin.

Daha fazla sekil ipucu eklemek i¢in bu islemi tekrarlayin. Yeni ipuglari sirasiyla ardindan
gelen harflerle gérundr (b, c, vs.).

Ttim sekil ipuglarini gériintiileme

Goériiniim > Sekil ipuclarini Géster'i segin. Sekil ipuglarini Géster'in kullanilabilir olmasi icin sekil

ipuclarini iceren katman ve ana kare etkin olmalidir.

Sekil ipucunu kaldirma
Sahne Alani'nin disina sariikleyin.

Tiim sekil ipuglarint kaldirma
Degistir > Sekil > Tim ipuglarini Kaldir'i segin

Ornek:

Bu drnekte bir metnin baska bir metne dénismesini saglayacak bir sekil arasi uygulayacagiz. Metnin
dogru bir sekilde donlismesi igin sekil ipuglarini da kullanacagiz.
1. Oncelikle yeni bir dosya olusturup sahneye siyah yazi tipinde bir metin ekleyin. Or: AFAD
2. 24.Kareye gidip bir anahtar kare (keyframe) ekleyin ve metni ve rengini degistirin. Or:
Animate
3. 1. Anahtar kareye gidip metin kutusu segiliyken metni pargalamaliyiz. Bunun igin Ctrl+B
kisayolunu veya Modify>Break Apart secenegini kullanmaliyiz. ilk kez parcalama islemi



gerceklestiginde metin harflerine ayrilacak. Dolayisiyla sekle donistiirmek igin bir kez daha
ayni islemi tekrarlamaliyiz.

4. ilk metin icin yaptigimiz islemi 24. Karedeki metin icin de yapmaliyiz.

5. Parcalama islemi bittikten sonra zaman gizelgesinde iki anahtar kare arasindaki herhangi bir
kareye sag tiklayip Create Shape Tween (Sekil arasi olustur) secenegine tiklayacagiz. Ctrl+
Enter’a basarak animasyonu test edebilirsiniz.

Create Motion Tween
Create Shape Tween
Create Classic Tween

Convert to Frame-by-Frame Animation > kFAD

Insert Frame
Remove Frames

Insert Keyframe

Insert Blank Keyframe

Clear Keyframe

Convert to Keyframes
Convert to Blank Keyframes

Cut Frames

Copy Frames

Paste Frames
Paste and Overwrite Frames
Clear Frames
Select All Frames
Copy Motion
Paste Motion
Reverse Frames
Synchronize Symbols
Split Audio

Actions

6. Son olarak bu animasyonun tam istedigimiz gibi olmasi icin sekil ipucu ekleyecegiz. ilk
anahtar kareye gidip Modify>Shape>Add Shape Hint seceneginden veya Ctrl+Shift+H
kisayoluyla 4 tane sekil ipucu ekleyelim.

Modify

Text Commands Control Debug Window Help

Document... Ctrl+)
Convert to Symbol.. F8
Convert to Bitmap
Break Apart Ctrl+B
Bitmap b
Symbol >
Shape > Smooth
Combine Objects > Straighten
Timeline y Advanced Smooth.. Ctrl+Alt+Shift+M
Advanced Straighten... Ctrl+Alt+Shift+N
Transform > . )
Optimize... Ctrl+Alt+Shift+C
Arrange >
Align 5 Convert Lines to Fills
Expand Fill...
Group Ctrl+G
- - Soften Fill Edges...
Ungroup Ctrl+Shift+G

Add Shape Hint Cyrl+Shift+H
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Seklin ortasina st Uste d harfine kadar minik daireler eklenmeli.

ik olarak birinci karede bu ipuglarini sekil Gizerine dagitip, ayni harfteki ipuclarini son karede
yaklasik olarak benzer noktalara tasimaliyiz.

Eger yerlestirme islemini dogru yaptiysa ilk karede ipuglari sari, son karede yesil
gériinmelidir. islem bittikten sonra Ctrl+Enter’a basarak animasyonu test edebliriz.

AFAD =) Animate



